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Getting Started with Internet Explorer 7.0

| Forward and Backward Buttons |
| Tabs | | Commands Toolbar |

| Drop Down Menu |

= West Chester Universityr of Pennsylvania - Microsoft Internet Explorer provided by WCU of PA

'(—‘ - |@, htkpf fweupd.eduf \¢| || X | v

" \
File Edit Yiew Favorites Tools  Help \
[

* *‘1'% [g. ‘West Chester University of Pennsylvania Address Bar

‘ West Chester University

. OF PENNSYLVANIA 4
Favorites Center ¥ j
- b

i VISIT CAMPUS  ~ CONTACT INFO

iving | Information Resources | Student Life | Searches

SEARCH
Enter keywords here. 0
POPULAR LINKS
f Summer
ch' iy Session
= Undergraduate % § Graduate
i Admizzions Studies
Plan For Excellence o
Current Prozpective
CAMPUS ANNOUNCEMENTS T Students g Students
This Week at WCU... »View More TTET Registrar & AR Y )
& Academic ““ Library
President Adler Announces Decision To Retire...  =View More e Calendar
New Student Orientation... View More = ™ Fi i
5 m Faculty & Staff b ﬁﬁi Egﬂ"c'ﬂ'
In Company With Angels... =View More =
Introduction

Internet Explorer 7 has new security and privacy features which allow you to browse the web
more safely.

e Phishing Filter can help protect you from phishing attacks such as online fraud and
spoofed websites.

e Higher security levels can help protect you from hackers and web attacks.

e The Security Status bar displays the identity of secure websites to help you make
informed decisions when using online banking or merchants.

e Internet Explorer's add-on disabled mode lets you start Internet Explorer without
toolbars, ActiveX controls, or other add-ons that might slow your computer.
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e Help prevent online attacks by keeping Internet Explorer up to date. Keeping Windows
and Internet Explorer up to date is one of the best ways to prevent trouble online.
Microsoft issues updates periodically which can help prevent online attacks through
known vulnerabilities and provides these updates free of charge through Windows
Update. If your computer is not set up to automatically receive updates, you can manually
request these updates by using Internet Explorer.

1. Click the Tools button ™~

T |2z Page - ¥ -
2. Then click Windows Updates
Pop-up Blocker 4
Fhishing Filter 3
Manage Add-ons 3

Wark OFfline
Windows Update

Full Screen F11
Menu Bar
Toolbars »

Sun Java Console

Inkernet Cptions

3. Follow the prompts on the screen to check for updates.
New Features

e Tabbed browsing is a new feature in Internet Explorer that allows you to open multiple
webpages in a single browser window. See page 8 for more information.

¢ The new Instant Search box # 7! lets you search the web
from the Address bar. You can also search using different search providers to get better

results. As you can see, Goggle appears as the search default in the box above. To change
the search default:

1. Select the down arrow next to the magnifying glass.

2. The following menu will appear » Google (Default)

Find on this Page. ..

Find More Providers. ..
Change Search Defaults, ..

3. To change the default, simply select Change Search Defaults.

4. The following box will appear where you will need to click the Find More
Providers link.

Page 4




Internet Explorer 7

Change Search Defaults fgl

E=plorer. ‘Y'ou can sef the default provider for the Addiess bar

The following search providers are available in Intemet
/{ and the Instant Search box below.

Search Providers:

Google [Default]

[SetDefauIt] [ Femove ]

< Find more providers... [ Ok ] I Cancel I

5. You will be redirected to a page where you can add whichever search provider
you choose.

Click the Favorites button w to open the Favorites Center to manage favorites, feeds,
and history in one place.

The Zoom feature lets you enlarge or reduce text, images, and some controls.

o7 Page -

1
1. To Zoom click the Page Tab. —
2. Next click Zoom and a side menu will appear.

Mews Window Cerl4-M

Save As...
Send Page by E-mail. ..
Send Link by E-mail. ..

Zoom
Text Size »
Encoding 3

Wiew Source

web Page Privacy Policy. ..
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3. Here you can select Zoom In, Zoom Out or a specific Zoom Percentage that you’d
like to use.

FoomIn  Chrl +
Zoarn Quk Ckrl -

400%s
200°%
150%:
125%:
& 100%:
5%
0%

Cuskorm,..

e Research Button: In IE 7, you have the opportunity to do research right from your
homepage, without having to navigate to a different site. You can access this feature by:
1. Open Internet Explorer
2. Select View >Explore Bar > Research
3. A research pane will appear on the left-hand side of your screen, where you can type
text to look up in a variety of research and reference services.

Note** If you are already researching information on a website and come to a word that you
don’t know the meaning of, simply hold down the ALT key on your keyboard and click the word
on that page. It will instantly go to your search box and searches will begin on the word you
selected. For this to work, the search box MUST already be open.

Helpful Information When Working in IE 7

How do I display the Internet Explorer menu?

The Pull-Down Menus that were displayed in earlier versions of Internet Explorer are turned off
in Internet Explorer 7, but you can turn them back on.

To display the menus temporarily:

1. Open Internet Explorer.
2. Press the ALT key.
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To display the menus permanently

1. Open Internet Explorer.
2. Click the Tools button = ™~ and then select Menu Bar.

Pop-up Blocker k
Phishing Filter
Manage &dd-ons *

-

Wiark, OFfline
Windows Lpdate
Full Screen Fi1

Toolbars K
Sun Java Console

Inkernet Cptions

To turn the menus off, repeat the steps above to clear the check mark.

Different Tool Bars in IE 7.0

1. Open Internet Explorer and on the right side of the web page select Tools.

EEX

o > IR IR 4R [ S

2. Select Toolbars from the drop down menu.

Pop-up Elocker 3
Phishing Filker 4
Manage Add-ons 3
Wark OFfline

wwindows Update

Full Screen F11

Menu Bar

Toolbats

Sun Java Console

Internet Options

3. A side menu will appear where you have the option of customizing and displaying certain
toolbars.
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What is it?

Tabhed Browsing

Tabbed browsing is a new feature in Internet Explorer that allows you to open multiple websites
in a single browser window. You can open webpages or links on new tabs, and switch between

them by clicking on the tab. If you have a lot of tabs open, you can use Quick Tabs 1281~ to
easily switch to other tabs. The advantage is that you have fewer items open on the taskbar.

How to Open a New Tab

1. To open a new blank tab click the New Tab button on the tab row or press CTRL+T.
pporer |

fon=edRepost=935 N

| & ewott e

B %0 - HA:

. @ ams @] Customize Links @ Dattebayo

ation Pluging Users Options  Upload

2. If you are opening a new tab for the first time, the following will appear in your tab:

y

You've opened a new tab

With tabs you can:

+ Use one Internet Explorer window to view all your webpages.
+ Open links in a background tab while viewing the page you're on.
+ Save and open multiple webpages at once by using favorites and home page tabs.

To get started:

+ Press the CTRL key while clicking links (or use the middle mouse button).
+ Click any tab with the middle mouse button to close it.
» Press ALT+ENTER from the address bar or search box to open the result in a new tab.

@ Learn more about tabs

@ Show more tab shortcuts

/vD Don't show this page again

A new tab will be opened to about:Tab, not about:blank.

e about:Tab includes a brief explanation of tabs. Click on the Don't Show Again button
to switch to about:blank.

¢  When you open a new tab to about:blank or about:Tab, the Address Bar is already
highlighted allowing us to quickly enter the URL that we want to visit.
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Group of Tabs

There are two types of Tab Groups - Grouped Favorites and Multiple Home Pages. Internet
Explorer also introduces a feature called Restore Last Tab Group.

Grouped Favorites

1. Open each page that you would like to have in your Favorites Group in its own tab. Once
you have done this, click on the Favorites menu then click on Add Tab Group to
Favorites.

W |$? | [‘:":'] [&Tabbed browsing - Inte. .

&dd ko Favarites.. .
Add Tab Group ko Favaorites, .

Impart and Expart, ..

Qrganize Favorites. ..

2. Decide on a Folder Name.

Favorites Center b__q

/ Add Tab Group to Favontes
Add the open tabz in this window to your favontes.

To access your favarites, wigit the Favorites Center.

Tab Group Hame: || |

Create in: | i Favarites b |

Cancel

3. Now open the Favorites Center by clicking the star on the toolbar. Navigate to the folder
containing the shortcuts. Click on the blue right-pointing arrow that appears on the right
hand edge of the folder entry.

|E| e 88] ]éTabbed browsing - Inte.. ]E
|r ¥ Favorites | Ey Feeds ¥ Histary - @
A

& Cemonstration pages

|5 Fies

I IE research

[ Links

|5 Microsaft -

All favorites stored in the folder will now open at the same time in their own tab.
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Multiple Home Pages

1. Go to Tools>Internet Options => General Tab. Creating multiple home pages is as
simple as hitting the enter key to go down a line, one URL per line:

Haome page
/? Tao create home page tabs, bype each address an ks own line,
|

hikkp: [ e ie-vista, com) .
htkp: ffinetesxplorer mvps.orgf|
Rikkp: f e, graail, oo -

[ IJse current H Ise default H Use blank ]

¢ Internet Explorer will open all of your home pages when you start Internet Explorer, or
when you click on the Home button on the toolbar.

2. If you wish you can set Internet Explorer to open only your first home page when it
starts. You will still be able to open all home pages by clicking on the Home button after
the option is enabled. Go to Tools - Internet Options = Settings (in the Tabs section.)

Tabbed Browsing Settings g|

Enable Tabbed Browsing {requires restarting Internet Explorer)

Warn me when closing rmultiple tabs

[ always switch to new tabs when they are created

Enable Quick Tabs {requires restarting Internet Explorer)
[]open anly the first home page when Internet Explorer starks
Open new tabs next to the current tab

[ open home page for new tabs instead of a blank page

‘Wwhen a pop-up is encountered:
() Let Internet Explarer decide how pop-ups should open
(%) always open pop-ups in a new window
() always open pop-ups in new tab

Open links From akher prograris in:
) & new windaw
(%) & new kab in the current window

(O The current tab or window

[ Restore defaults oK l [ Cancel
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¢ (lick on the drop-down arrow on the right edge of the Home button to access even more
options. You can open just one home page, add or change a home page, remove a home

page or remove all home pages.

ﬁv.

West Chester University of Pennsylvania
v MM, com

add or Change Home Page. ..

Remove

e If you click on Add or Change Home Page, Internet Explorer will offer to add the page
that is currently being displayed as a Home Page:

Addorianes Home P ase g

& Would you like to use the following as your home page?
L1
. S
() Use this webpage as your only home page

() Add this webpage to your home page tahs

{7 Use the current tab set as your home page

Saving a Group of Tabs
ahe

1. To save a group of tabs click the Add to Favorites button.

2. Then click Add Tab Group to Favorites.
| Add to Favorites... Ctrl+Dr

Add Tab Group bo Fawvarites. ..

Import and Export...

Qrganize Favorites. ..

3. Give the group a name.
4. Select the folder that you want the group to be stored in and then click Add.

Favorites Center fgl

Add Tab Group te Favorites

\t/\(. Add the open kabs in this window to pour favorites.
To access your favorites, visit the Favarites Center

Tab Group Mame: | |

]

Cancel

Create i |f§ Favorites

**Note: You need to have atleast two tabs active when the time comes when you want to save a
group of tabs. Otherwise, the Add Tab Group to Favorites option will not be accessible.**
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Opening a Saved Group of Tabs

1. Click the Favorites Center button. W

- Favarites |

2. Then click the Favorites button. [k
3. Go to the folder that contains the tab group you want to open and then click the arrow to

the right of the folder name, ="ieresaft iebsites <«
4. All of the webpages will open on separate tabs.

Restoring Tabs/Tab Groups

When you close Internet Explorer, you will be asked whether you want to close all tabs. When
the prompt appears:

Internet Explorer,

Do you want to cloze all tabs?

(=) Show Options Close Tabs ] [ Cancel

1. Click Show Options.
2. Select Open these the next time I use Internet Explorer.
3. Then click Close Tabs.

Internet Explorer

Do you want to cloze all tabs?

H Open these the nest time | use Intermet Explorer

[0 nat shawe me this dislog again

{&} Hide Options Close Tabs ] [ Cancel ]

4. When you reopen Internet Explorer the tabs will be restored.

Note**In IE 7, you can have as many as 10 tabs open at one time.
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Finding the Weh Pages You Want

Search From the Address Bar

When a website address cannot be found, Internet Explorer automatically searches the web to try
to find that site by using your default search provider. Follow these steps to set your preferences
for how this is done.

1. In Internet Explorer click the Tools button and then click Internet Options.

Pop-up Blocker L
Phishing Filter »
Manage Add-ons 3

windows Lpdate

Sun Java Consale

Internet Options

2. Click the Advanced tab.

Internet Options EJ El

General | Security | Privacy || Content | Connections F‘ru:ugr

3. In the Settings list scroll down until you find Search from the Address bar.
4. Do one of the following:
o To view a list of likely matches in the main window so that you can choose which
webpage to display, select Just display the results in the main window.
o To turn off searching from the Address bar, select Do not search from the
Address bar.
5. When you have made your selection click OK.

Search More Efficiently
Here are a few ideas for improving the results of searches:

e Use specific words rather than generic categories.

e Use quotation marks to search for specific phrases. Surrounding terms with quotation
marks limits the search results to only those webpages that contain the exact phrase
you've specified.

e Use the minus (-) sign before a keyword to tell search providers to exclude pages with
that term. Using a minus sign will retrieve webpages that do not include the word.

e Eliminate common words such as a, my, or the, unless you're looking for a specific title.
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e Use synonyms or alternative search terms.

e Search only a specific website or domain. Type the search term you're looking for
followed by site: and the address of the website you want to search to narrow the search
to that specific site. For example, to search Microsoft.com for information about viruses,
type virus site: www.microsoft.com.

Favorites, also known as bookmarks, are a convenient way to organize and link to webpages that
you visit frequently.

If you use Internet Explorer on several computers you can easily save your favorites on one
computer and import that list onto another computer. If you use both Internet Explorer and
another web browsing program, you can keep your favorites synchronized by importing them
between programs.

To Import or Export Favorites

1. Open Internet Explorer.
2. Click the Add to Favorites button, and then click Import and Export.
3. Follow the instructions in the Import/Export Wizard.

By default, the Import/Export Wizard creates a standard HTML file named bookmark.htm and
saves it in the My Documents folder. When you use the wizard to import your favorites, it will
look for that file.

Keep Track of your Favorite Webpages

e Add a page to your list of favorites: Any time you want to open that page, click the

Favorites Center button ** on the toolbar and then click the shortcut in the list.

e Add the page to the Links bar: Put the websites you visit most frequently on the Links
bar and they're always only one click away.

e Make the page your home page: If there is one page that you always want to go to,
make it your home page. If there are several webpages that you visit on a daily basis, you
might want to make those into a set of home page tabs so they appear every time you start
Internet Explorer.

Note**If you recently visited a webpage and want to find it again but you didn't save the link,

click the Favorites Center button ™ , and then click History.
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How to Organize Favorites

1. In Internet Explorer, click the Add to Favorites button ** , and then click Organize

Favorites. —
g iGoogle

Add to Favorites. .. Chrl+D

Import and Export..,

Crganize Fawvorites. ..

2. In the Organize Favorites dialog box, you will see a list of your favorite links and
folders. From here you can do the following:

o Open folders: Click a folder to expand it and see the links it contains.

o Create new folders: Click New Folder, type a name for it, and then press
ENTER.

o Move favorites: Select a link or folder and then drag it to the new position or
folder. You can also move items by selecting the link or folder, clicking Move,
and then choosing the folder you want to move it to.

o Rename links or folders: Select a link or folder, and then click Rename. Type
the new name, and then press ENTER.

o Delete links or folders: Click a link or folder, click Delete and then click Yes to
remove it.

3. When you are finished organizing your favorite links click Done.

Folders are used to organize your favorite links into groups that are meaningful to you.

1. In Internet Explorer click the Add to Favorites button and then click Organize
favorites.

2. In the Organize Favorites dialog box click New Folder type a name for the folder, and
then press ENTER.

3. Drag favorites from the list into the appropriate new folders. You can create nested
folders by dragging one folder into another.

4. When you are finished creating and organizing folders click Done.

setting Up Your Homepage

To Set the Current Page as the Homepage
To make the webpage you're currently on your home page follow these steps:

1. If you have not already done so open Internet Explorer and go to the page you want to
use as the home page.

2. Click the arrow to the right of the Home button 5 “2nd then click Add or Change
home page.
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In the Add or Change Home Page dialog box, do one of the following:

Add or, Change Home Page g]

/‘ Would you like to use the following as your home page?
5

“F http: S, google, comfig?hl=en

() Use this webpage as your only home page
(O add this webpage ko your home page tabs

To make the current webpage your only home page click Use this webpage as your only
home page.

To start a home page tab set or to add the current webpage to your set of home page tabs
click Add this webpage to your home page tabs.

To replace your existing home page or home page tab set with the webpages you
currently have open, click Use the current tab set as your home page. This option will
only be available if you have more than one tab open in Internet Explorer.

Click Yes to save your changes.

Note**To have more than one homepage tab appear when opening IE 7, See Multiple Home
Pages on page 10 of this document.

To Reset Homepage as Default

To reset the home page to the one that was used when Internet Explorer was first installed,
follow these steps.

1. Open Internet Explorer.

2. Click the Tools button and then click Internet Options.

3. Click the General tab.

4. Click Use default to replace your current home page with the one that was used when
you first installed Internet Explorer.

5. Click OK to save your changes.

To Delete a Homepage

1. Open Internet Explorer.

2. Click the arrow to the right of the Home button 5 and then click Remove to open a
list of your home pages.

3. Do one of the following:

[ ]

To delete one home page click that page and then click Yes.
To delete all home pages click Remove All and then click Yes.
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Reorganize Homepage Tabs

By default home page tabs are ordered chronologically with the most recently added webpage
being the first tab. To reorder the home page tabs follow these steps:

el NS

a

Open Internet Explorer.

Click the Tools button and then click Internet Options.

Click the General tab.

Under Home Page select the home page you want to move right-click it and then click
Cut.

Click at the beginning of the line where you want to move the home page address and
then press ENTER to create an empty line. Right-click the empty line and then click
Paste.

Repeat steps 4 and 5 for each home page you want to move.

Click OK to save your changes and exit.

Note**Refer to Tabbed Browsing if you want to back up your homepage or save homepage tabs.

To Print a Webpage
1. In Internet Explorer go to the webpage that you want to print.
2. Click the arrow to the right of the Print button and then click Print.
T g=h |-
Prink Presdiew...
Page Setup...
3. Set the printing options you want and then click Print.

Printing Notes**

To print content that is in a frame right-click the frame click Print and then in the Print
dialog box click Print.

To print a picture right-click the picture, click Print Picture and then in the Print dialog
box click Print.

To print a specific section of a webpage select that section, right-click the section and
then click Print. In the Print dialog box click Selection and then click Print.

To preview how a webpage will look when it is printed click the arrow to the right of the
Print button and then click Print Preview. In Print Preview, you can make changes to
how the page will print (including rotating, shrinking, or stretching it).
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To Save a Webpage on your Computer

In Internet Explorer click the Page button and then click Save As.

Go to the folder you want to save the page in.

In the File name box type a name for the page.

In the Save as type box do one of the following:

To save all of the files needed to display this page, including graphics, frames, and style
sheets select Webpage complete. This option saves each file in its original format.

To save all of the information needed to display this page in a single file, click Web
Archive single file.

e To save just the current HTML page click Webpage, HTML only.

e To save just the text from the current webpage click Text File.

o~ L~

security & Privacy

Pop-Up Blocker

Pop-up Blocker is a feature in Internet Explorer that lets you limit or block most pop-ups. You
can choose the level of blocking you prefer, from blocking all pop-up windows to allowing the
pop-ups that you want to see. When Pop-up Blocker is turned on, you will get an Information bar
message saying "Pop-up blocked. To see this pop-up or additional options click here."

To turn Pop-up Blocker on or off

1. In Internet Explorer click the Tools button and then click Pop-up Blocker.
2. Do one of the following:

o To turn off Pop-up Blocker click Turn Off Pop-up Blocker.

o To turn on Pop-up Blocker click Turn On Pop-up Blocker.

To change Pop-up Blocker Settings:

1. In Internet Explorer click the Tools button click Pop-up Blocker and then click Pop-up
Blocker Settings.
2. Make any changes that you would like and then click Close.

Cookies

Websites use cookies to offer a personalized experience to users and to gather information about
website use. Many websites also use cookies to store information from a shopping cart or
customized pages. With a trusted website, cookies can enrich your experience by allowing the
site to learn your preferences or allow you to skip having to sign in every time you go to the
website. However, some cookies, such as those saved by banner ads, might put your privacy at
risk by tracking sites you visit.
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To delete all cookies:

1. In Internet Explorer click the Tools button and then click Internet Options.
2. On the General tab under Browsing history click Delete.

3. Click Delete cookies and then click Yes.

4. Click Close and then click OK.

Note**Cookies are stored in a folder named Cookies which is stored inside the Documents and
Settings folder. By default, the path is C:\Documents and Settings\your user name\Cookies.

Content Advisor

Content Advisor is a tool for controlling the types of content that your computer can access on
the Internet. After you turn on Content Advisor, only rated content that meets or exceeds your
criteria can be viewed. You can adjust the settings to suit your preferences.

You can do the following:

e View and adjust the ratings settings to restrict or allow content in each of the following
categories: language, nudity, sex, and violence.

e Create a list of websites that should always be blocked, regardless of how their content is
rated.

e Create a list of websites that can always be viewed, regardless of how their content is
rated.

e View and change the ratings systems Content Advisor uses.

Content Advisor is not turned on by default. To turn on Content Advisor:

1. In Internet Explorer click the Tools button and then click Internet Options.
2. Click the Content tab and then under Content Advisor click Enable.

[2x]
General | Security || Privacy | Content | Connections | Programs | Advanced

Content Advisor
@ Ratings help you control the Internet content that can be

vigwed on this computes

Cettificates

A

[ Clear 55L state ] [ Certificates ] [ Publishers ]

Use certificates For encrypted connections and identification.

AukaComplete

:22 AutoComplete stores previous entries Settings

y on webpages and suggests matches
for wou,
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If you've never turned on Content Advisor before continue to the next step. If you've
previously turned on Content Advisor type your supervisor password and click OK until
you return to Internet Explorer. Content Advisor is now turned on and you should not
continue to the next step.

3. Click a category in the list and then move the slider to set the limits you want to use.

Content Advisor §|

Ratings | Approved Sites || General | Advanced

Select a category to view the rating levels:
) ITRAZ ~
LAl Content that creates fear, intimidation, etc.
ZI\\ Content that zets a bad example for young children
ZI\\ Depiction of alcohol use
Q\ Drepiction of drug use
Q [repiction of gambling b

Adjust the slider to specify what uzers are allowed to see:

J

4. Repeat this process for each category you want to limit and then click OK.
5. Type a supervisor password, confirm it and type a hint that will remind you what the
password is. Click OK.

Create Supervisor Password E|

To prevent unauthonized uzers from changing
Content Advizor settings. provide a pazsword.

Content Advisor settings can be changed or
turmed on or off only by people who know the
password.

Password: |

Confirm pazsword:

Pravide a hint to help you remember your password. Set the hint
20 that others cannot uze it to easily guess pour password.

Hint:

[ 0K ] [ Cancel ]

6. After Content Advisor is enabled the next time you want to update settings, the following
box will appear where you have the option of disabling content advisor or change
settings.

izeneral || Security || Privacy | Content | Copmections | Programs | Advanced

Conkent Adwvisor

Q\ Ratings help you control the Inkernet conkent that can be
wiewwed on this computer,

Cisable. ., ] [ Settings
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The Information bar is the place where Internet Explorer displays information about security
downloads, blocked pop-up windows, and other activities. It is located at the top of the webpage.

[_T=Ted
(=R = )
ir
DI I,
= ==
-y =
. Error: Phagn natal Frrer
The Meowell Zkbuarcgles Degketors Manaoement phigm conld aot be patalled. Lilesly cqnzes welods
+ The page reforences an incomectingal sowce
s Yeu de ner bave pufficiss: nohde 1o pafommn the cperanen.
bt HE sapklng noooisay ackons
Fraze contact the sysiem admimstrator for more help
1J Dene: ® Inboerct

If Internet Explorer is still using its original settings you'll see the Information bar in the
following circumstances:

e If a website tries to install an ActiveX control on your computer or run an ActiveX control in an
unsafe manner.

If a website tries to open a pop-up window.

If a website tries to download a file to your computer.

If a website tries to run active content on your computer.

If your security settings are below recommended levels.

If you started Internet Explorer with add-ons disabled.

If you need to install an updated ActiveX, or add-on program.

Turning Off Information Bar (not recommended)
If you want to turn it off, you have to turn it off for each type of message.
To turn off Information bar messages about blocked pop-up windows:
1. Open Internet Explorer.
Click the Tools button click Pop-up Blocker and then click Pop-up Blocker Settings.

3. Clear the Show Information Bar when a pop-up is blocked check box and then click
Close.
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To stop the Information bar from blocking file and software downloads

1. Open Internet Explorer.
2. Click the Tools button and then click Internet Options.
3. Click the Security tab and then click Custom level.

F.

General | Security | Privacy | Content | Connections | Programs | Advanced

Select a zone to view or chan_ga security settings,

@ € J o

Internet Local intranet Trusked sites Restricted s ¥
Internet
@ This zone is for Internet websites,
except those listed in trusted and
restricted 2ones,

Security level Far this zone

Security Settings - Internet Zone

Settings

[£14 . HET Frameniark
1% Loose KAML
) Disable
(& Enable
O Prompt
:3 WAML browser applications
) Disable
(&) Enable
O Prompt
(o2 %PS documents
) Disable
(&) Enable
) Prompt
S NET Framework-reliant components
% Fun components not signed with Authenticode

Allovwed levels For this zone: Medium to High N Mieshla
Medium-high < )
= - Appropriate For mast websites *Takes effect after you restart Internet Explarer
- Prompts before downloading potentially unsafe
R Reset custom settings
- Unsigned Actives controls will not be downloaded Reset ka: Mediom-high {default) v

Custom level...

4. Do one or both of the following:

o To turn off the Information bar for file downloads scroll to the Downloads
section of the list and then under Automatic prompting for file downloads click
Enable.

o To turn off the Information bar for ActiveX controls scroll to the ActiveX
controls and plug-ins section of the list and then under Automatic prompting
for ActiveX controls click Enable.

5. Click OK then click Yes to confirm that you want to make the change and then click OK
again.

Customize Internet Explorer Toolbhars

Internet Explorer has several toolbars: the drop-down menu, the links toolbar, and the Command
Bar. The Command bar is located at the top right side of the Internet Explorer window (it
contains the Home icon, among others) and it offers easy access to almost any setting or feature
in Internet Explorer. You can customize the Command Bar buttons to suit your preferences and
add website links to the Links bar.
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Change Buttons on the Command Bar

1. In Internet Explorer right-click the Command bar, point to Customize Command Bar
and then click Add or Remove Commands.

Menu Bar
Links
Status Bar

Lock the Toolbars
Use Large Icons

Customize Command Bar  # Show all Text Labels
W Show Selective Text
Show Only Icons

add ar Remove Commands, ..

2. Make one or more of the following changes:
o To add a button click the button you want to add in the Available toolbar
buttons list and then click Add.
o To remove a button, click the button you want to remove in the Current toolbar
buttons list then click Remove.
o To change the order in which buttons are displayed click a button in the Current
toolbar buttons list and then click either Move Up or Move Down.
o To restore the Command bar buttons to their default settings click Reset.
3. When you're done, click Close.

Note**You should see your changes immediately. If you've added a lot of buttons, you might
need to resize the Command bar to see them all.

Resize the Command Bar
1. In Internet Explorer right-click the Command bar and then click Lock the Toolbars to
clear the check mark (if the check mark is already gone skip this step).

Drag the Command bar separator bar ' leftor right.
3. When you're done right-click the Command bar and then click Lock the Toolbars.

N
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Change the Colors Used For Webpages
You can choose the colors that Internet Explorer uses for webpage text, backgrounds, and links.

1. In Internet Explorer click the Tools button and then click Internet Options.
2. Click the General tab and then click Colors.

etaroatintiate: !ﬂ!
General Security | Privacy | Content | Connections | Programs | Advanced
Home page
To create home page tabs, type each address on its own line.
g rie
aF htkp: e, google, com]
[ Use current I [ Use defaul ] [ Use: blank.
Browsing hiskory
% Delete kemporary files, history, cookies, saved passwords,
¥ and web Form information.
Setkings
Search
—~
( /‘ Change search defaults. Seftings
ra
Tabs
Change how webpages are displayed in Settings
tabs.
Pearance
[ Colors ] [)Languages l [ Fonts ] [ Accessibility ]

3. Clear the Use Windows colors check box so that it will look like the box on the right.

Colors E| Colors E|
[ use haver color [ use hover color
Calors Colors
- e Windows calors ; [[] Use Windaws calars
Fb
Text: |
Background: [
Yisited: I
Unvisited: ||
How ko ignore preset colors How bo ignore preset colors

4. Do any of the following:

o To change the color that is used for text click the box to the right of Text click the
color you would like to use for text and then click OK.

o To change the color that is displayed in the background click the box to the right
of Background click the color you would like to use, and then click OK.

o To change the color used for links you have already visited, click the box to the
right of Visited, click the color you want to be used for visited links, and then
click OK.

o To change the color used for links you have not visited, click the box to the right

of Unvisited, click the color you want to be used for unvisited links, and then
click OK.
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o To change the color that a link will become when you point at it, select the Use
hover color check box, click the box to the right of Hover, click the color you
would like links to change to when the mouse pointer hovers over them, and then
click OK.

5. Click OK to close the dialog box.

This Information was obtained from Internet Explorer 7.0’s Help Section. You can find more

helpful information by clicking the Help Button @- inlE 7.
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